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the students.”
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training series from Adobe Systems Incorporated, developed with the support 
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Adobe Premiere Pro CC Classroom in a Book (2015 release) contains 18 lessons 
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help you become more productive with the program.
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• the complete text of the book
• interactive quizzes
• videos that walk you through the lessons step by step and more
• updated material covering new features released by Adobe

What you need to use this book: Adobe Premiere Pro CC (2015 release)
so� ware, for either Windows or Mac OS. (So� ware not included.)

Note: Classroom in a Book does not replace the documentation, support, updates, 
or any other bene� ts of being a registered owner of Adobe Premiere Pro so� ware. 
Includes DVD-ROM with lesson � les.
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Learn to edit video in Adobe Premiere Pro CC (2015 release) 
and get the most out of your work� ow. Take a project from 
beginning to end and learn to organize media, add audio, 
create transitions, produce titles, and add e� ects. Take your 
projects further by sweetening and mixing sound, compositing 
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WHERE ARE THE LESSON FILES?
Purchasing this Classroom in a Book gives you access to the lesson files you’ll need 
to complete the exercises in the book.

You’ll find the files you need on your Account page at peachpit.com on the  
Lesson & Update Files tab.

For complete instructions, see the last two pages of this ebook, “How to Get Your 
Lesson Files”.
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Adobe Premiere Pro CC, the essential editing tool for video enthusiasts and 
professionals, is the most scalable, efficient, and precise video-editing tool 
available. It supports a broad range of video formats, including AVCHD, HDV, 
XDCAM EX, HD and HD422, P2 DVCPRO HD, AVC-Intra, Canon XF, RED R3D, 
ARRIRAW, Digital SLR, Blackmagic CinemaDNG, Avid DNxHD, QuickTime and 
AVI files, GoPro Cineform, and many more. Premiere Pro lets you work faster 
and more creatively without converting your media. The complete set of powerful 
and exclusive tools lets you overcome any editorial, production, and workflow 
challenges to deliver the high-quality work you demand.

About Classroom in a Book
Adobe Premiere Pro CC Classroom in a Book (2015 release) is part of the official 
training series for Adobe graphics and publishing and creative video software. 
The lessons are designed so that you can learn at your own pace. If you’re new to 
Premiere Pro, you’ll learn the fundamental concepts and features you’ll need to use 
the program. This book also teaches many advanced features, including tips and 
techniques for using the latest version of this software.

The lessons in this edition include opportunities for hands-on practice using 
features such as chromakeying, dynamic trimming, color correction, tapeless 
media, audio and video effects, and advanced integration with Adobe After Effects, 
Adobe SpeedGrade, and Adobe Audition. You’ll also learn how to create files for 
the Internet and mobile devices with Adobe Media Encoder. Premiere Pro CC is 
available for both Windows and Mac OS.

Prerequisites
Before beginning to use Adobe Premiere Pro CC Classroom in a Book, make sure 
your system is set up correctly and that you’ve installed the required software and 
hardware. You can view updated system requirements here:

helpx.adobe.com/premiere-pro/system-requirements.html

GETTING STARTED
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You should have a working knowledge of your computer and operating system. You 
should know how to use the mouse and standard menus and commands and also 
how to open, save, and close files. If you need to review these techniques, see the 
printed or online documentation included with your Windows or Mac OS system.

Installing Premiere Pro CC
You must purchase an Adobe Creative Cloud subscription separately from this 
book. For complete system requirements and complete instructions on installing 
the software, visit www.adobe.com/support. You can purchase Adobe Creative 
Cloud by visiting www.adobe.com/products/creativecloud. Follow the onscreen 
instructions. You may also want to install Photoshop, After Effects, Audition, 
Prelude, SpeedGrade, Encore (available only with Premiere Pro CS6), and Adobe 
Media Encoder, which are included with Adobe Creative Cloud.

Optimizing performance
Editing video places high demands on your computer processor and memory. 
A fast processor and a lot of memory will make your editing experience faster and 
more efficient. This translates to a more fluid and enjoyable creative experience.

Premiere Pro takes advantage of multicore processors (CPUs) and multiprocessor 
systems. The faster the processors, the better the performance you’ll experience.

The minimum system memory is 4 GB, and 8 GB or more is recommended for 
high-definition (HD) media.

The speed of the storage drives you use for video playback is also a factor. A dedi-
cated fast storage drive is recommended for your media. A RAID disk array or 
solid-state disk is strongly recommended, particularly if you’re working with 4K or 
higher-resolution media. Storing your media files and program files on the same 
hard drive can affect performance. Keep your media files on a separate disk if at all 
possible.

The Premiere Pro Mercury Playback Engine can utilize the power of your GPU, 
harnessing the power of your computer’s graphics hardware to improve playback 
performance. GPU acceleration provides a significant performance improvement, 
and most video cards with at least 1 GB of dedicated memory will also work. You 
can find more information about hardware and software requirements on the 
Adobe website at http://helpx.adobe.com/premiere-pro/system-requirements.html.

http://www.adobe.com/support
http://www.adobe.com/products/creativecloud
http://helpx.adobe.com/premiere-pro/system-requirements.html
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Using the lesson files
The lessons in this book use supplied source files, such as video clips, audio files, 
and image files created in Adobe Photoshop CC and Adobe Illustrator CC. To com-
plete the lessons in this book, you must copy all the lesson files to your computer’s 
storage drive. Although each lesson stands alone, some lessons use files from other 
lessons, so you’ll need to keep the entire collection of lesson assets on your storage 
drive as you work through the book. You will need about 8 GB of storage space in 
addition to the 4 GB you need to install Premiere Pro CC.

If you have purchased an ebook edition of this book, you’ll need to download the 
lesson files from peachpit.com. You’ll find instructions for doing so on the first page 
of this book, in the section “How to get your lesson files.”

If you've purchased the printed version, you’ll copy the lesson files from the Adobe 
Premiere Pro CC Classroom in a Book disc (inside the back cover of this book).

Here’s how to copy those assets from the disc to your storage drive:

1	 Open the Adobe Premiere Pro CC Classroom in a Book disc in My Computer or 
Windows Explorer (Windows) or in Finder (Mac OS).

2	 Right-click the folder called Lessons and choose Copy.

3	 Navigate to the location you have chosen to store your Premiere Pro projects, 
righ-click, and choose Paste.

Following these steps will copy all the lesson assets to your local storage drive. This 
process may take a few minutes to complete, depending on the speed of your hardware.

If you are accessing the files from the ebook version of this book, follow the direc-
tions on the first page of the ebook.

Relinking the lesson files
The Premiere Pro projects included with the lesson files have links to specific 
media files. Because you are copying the files to a new location, those links may 
need to update when you open projects for the first time.

If you open a project and Premiere Pro is unable to find a linked media file, 
the Link Media dialog may open, inviting you to relink offline files. If this 
happens, select an offline clip and click the Locate button to use the browser 
to locate it.

A browser panel will appear. Locate the Lessons folder using the navigator on the 
left, and click Search. Premiere Pro will locate the media file inside the Lessons 
folder. To hide all other files, making it easy to select the right one, select the option 
to display only exact name matches.

E	Tip:  If you don’t 
have dedicated storage 
for your video files, 
placing the lesson files 
on your computer’s 
desktop will make them 
easy to find and work 
with.

## Note:  If media files 
were originally stored 
in multiple locations, 
you may need to search 
more than once to 
relink all the media for a 
project.
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The last known file path and file name and the currently selected file path and file 
name are displayed at the top of the panel for reference. Select the file and click OK.

The option to relink other files is enabled by default, so once you’ve located one file, 
the rest should reconnect automatically. For more information about relocating 
offline media files, see Chapter 17, “Managing Your Projects.”

How to use these lessons
The lessons in this book provide step-by-step instructions. Each lesson stands 
alone, but most build on previous lessons in terms of concepts and skills. The best 
way to learn from this book is to proceed through the lessons one after another.

The lessons teach you new skills in the order you might use them while performing 
post-production for a real project. Rather than being feature-oriented, this book 
uses a real-world approach. The lessons begin with acquiring media files such as 
video, audio, and graphics, and go on to creating a rough cut sequence, adding 
effects, sweetening the audio, and ultimately exporting the project.

By the end of these lessons, you'll have a good understanding of the end-to-end 
post-production workflow, with the specific skills you need to edit on your own.

Web Edition
This book comes with a free Web Edition that can be accessed from any device with 
a connection to the Internet. Its benefits include:

•	 The complete text of the book

•	 Hours of instructional video keyed to the text

•	 Interactive quizzes

In addition, the web edition will be updated when Adobe adds significant feature 
updates between major Creative Cloud releases. To accommodate the changes, 
sections of the online book will be updated or new sections will be added.

Accessing the Web Edition
Your purchase of this Classroom in a Book in any format includes access to the 
corresponding web edition. The web edition contains the complete text of the book 
augmented with hours of video and interactive quizzes.

If you purchased your book from peachpit.com or adobepress.com, your book is 
automatically registered. You can find the link to your free Web Edition on the 
Digital Purchases tab of your Account page.
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If you purchased your book through any other channel, you must register it.

1	 Go to www.peachpit.com/register.

2	 Sign in or create a new account.

3	 Enter ISBN: 9780134309989.

4	 Answer the questions as proof of purchase.

5	 The Web Edition will appear on the Digital Purchases tab of your Account page. 
Click the Launch link to access the product.

Additional resources
Adobe Premiere Pro CC Classroom in a Book (2015 release) is not meant to replace 
documentation that comes with the program or to be a comprehensive reference 
for every feature. Only the commands and options used in the lessons are explained 
in this book. For comprehensive information about program features and tutorials, 
refer to these resources:

Adobe Premiere Pro CC Learn and Support: helpx.adobe.com/premiere-pro is 
where you can find and browse Help and Support content on Adobe.com. Adobe 
Premiere Pro Help and Adobe Premiere Pro Support Center are accessible from 
the Help menu in Premiere Pro. Help is also available as a printable PDF document. 
Download the document at helpx.adobe.com/pdf/premiere_pro_reference.pdf.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions, and answers on Adobe products.

Adobe Premiere Pro CC product home page: adobe.com/products/premiere has 
more information about the product.

Adobe Add-ons: creative.adobe.com/addons is a central resource for finding 
tools, services, extensions, code samples, and more to supplement and extend your 
Adobe products.

Resources for educators: adobe.com/education and edex.adobe.com offer a 
treasure trove of information for instructors who teach classes on Adobe software. 
You’ll find solutions for education at all levels, including free curricula that use an 
integrated approach to teaching Adobe software and can be used to prepare for the 
Adobe Certified Associate exams.

Adobe Authorized Training Centers
Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory of 
AATCs is available at training.adobe.com/trainingpartners.

http://www.peachpit.com/register
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Organizing Media

Lesson overview
In this lesson, you’ll learn about the following:

•	 Using the Project panel

•	 Staying organized with bins

•	 Adding metadata to your clips

•	 Using essential playback controls

•	 Interpreting footage

•	 Making changes to your clips

This lesson will take approximately 50 minutes.

4
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Once you have some video and sound assets in your 
project, you’ll begin looking through your footage 
and adding clips to a sequence. Before you do, it’s well 
worth spending a little time organizing the assets you 
have. Doing so can save you from spending hours of 
hunting for things later.



64  Lesson 4 O rganizing Media

Getting started
When you have lots of clips in your project, imported from several different media 
types, it can be a challenge to stay on top of everything and always find that magic 
shot when you need it.

In this lesson, you’ll learn how to organize your clips using the Project panel, which 
is the heart of your project. You’ll create special folders, called bins, to divide your 
clips into categories. You’ll also learn about adding important metadata and labels 
to your clips.

You’ll begin by getting to know the Project panel and organizing your clips.

1	 To begin, reset the workspace to the default. In the Workspace panel, click 
Editing. Then click the menu adjacent to the Editing option and choose Reset to 
Saved Layout.

2	 For this lesson, you’ll use the project file you used in Lesson 3, “Importing 
Media.” Continue to work with the project file from the previous lesson, or open 
it from your hard drive.

3	 Choose File > Save As.

4	 Rename the file Lesson 04.prproj.

5	 Choose a preferred location on your hard drive, and click Save to save the 
project.

If you do not have the previous lesson file, you can open the file Lesson 04.prproj 
from the Lessons/Lesson 04 folder.

Using the Project panel
Anything you import into your Adobe Premiere Pro CC project will appear in the 
Project panel. As well as giving you excellent tools for browsing your clips and 
working with their metadata, the Project panel has special folders, called bins, that 
you can use to stay organized.

Anything that appears in a sequence must be in the Project panel. If you delete 
a clip in the Project panel that is already used in a sequence, the clip will 
automatically be removed from the sequence. Premiere Pro will warn you if 
deleting a clip will affect an existing sequence.



Adobe Premiere Pro CC Classroom in a Book (2015 Release)  65

HeadingsPanel Menu

Find New Item

New Bin

Zoom

Panel Tab

Filter

Sequence

Clip

List 
View

Icon 
View

Hidden Panels

As well as acting as the repository for all your clips, the Project panel gives you 
important options for interpreting media. All of your footage will have a frame rate 
(frames per second, or fps) and a pixel aspect ratio (pixel shape), for example. You 
may want to change these settings for creative reasons.

You could, for example, interpret video recorded at 60fps video as 30fps to achieve 
a 50% slow-motion effect. You might also receive a video file that has the wrong 
pixel aspect ratio setting.

Premiere Pro uses metadata associated with footage to know how to play it back. 
If you want to change the clip metadata, you can do so in the Project panel.

Customizing the Project panel
It’s likely that you’ll want to resize the Project panel from time to time. You’ll 
alternate between looking at your clips as a list or as thumbnail icons. Sometimes 
it’s quicker to resize the panel than to scroll to see more information.

The default Editing workspace is designed to keep the interface as clean as possible 
so you can focus on your creative work. Part of the Project panel that’s hidden 
from view by default, called the Preview Area, gives additional information about 
your clips.
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Let’s take a look at it:

1	 Click the panel menu for the Project panel (on the panel tab).

2	 Choose Preview Area.

The Preview Area displays useful information for clips you select.

The Preview Area shows you several kinds of useful information about a clip 
when you select it in the Project panel, including the frame size, pixel aspect 
ratio, and duration.

Duration and frame sizeAudio type 

Play/Stop 

Frame size Clip type Clip name Poster frame 

If it is not already selected, click the List View button (   ) at the bottom left of 
the Project panel. In this view, you’ll find a lot of information about each clip in 
the Project panel, but you need to scroll horizontally to see it.

The Preview Area gives you a mix of information about clips when you need it.

3	 Click the panel menu for the Project panel (on the Panel tab).

4	 Choose Preview Area to hide it.

Finding assets in the Project panel
Working with clips is a little like working with pieces of paper at your desk. If 
you have just one or two clips, it’s easy. But when you have 100 to 200, you need a 
system.

E	Tip:  There’s a quick 
way to toggle between 
seeing the Project panel 
in a frame and seeing 
it full-screen: Hover 
your mouse cursor over 
the panel and press the 

` (grave) key. You can 
do this with any panel. 
If your keyboard does 
not have a ` (grave) 
key, you can click the 
panel menu and choose 
Panel Group Settings > 
Maximize Panel Group.
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One way you can help make things smoother during the edit is to invest a little 
time in organizing your clips at the beginning. If you name your clips during 
capture or after importing them, it can help enormously. Even if you don’t give each 
clip its own name during capture from tape, you can give a name to each type of 
shot and let Premiere Pro add 01, 02, 03, and so on (see Lesson 3).

1	 Click the Name heading at the top of the Project panel. The items in the Project 
panel are displayed in alphabetical order or reverse alphabetical order each time 
you click the Name heading again.

If you’re searching for several clips with particular features—such as a duration 
or a frame size—it can be helpful to change the order in which the headings are 
displayed.

2	 Scroll to the right until you can see the Media Duration heading in the Project 
panel. This shows the total duration of each clip’s media file.

3	 Click the Media Duration heading. Premiere Pro now displays the clips in order 
of media duration. Notice the direction arrow on the Media Duration heading. 
Each time you click the heading, the direction arrow toggles between showing 
clips in duration order or reverse duration order.

	

4	 Drag the Media Duration heading to the left until you see a blue divider 
between the Frame heading and the Name heading. When you release the 
mouse button, the Media Duration heading will be repositioned right next to 
the Name heading.

The blue divider shows where you will drop the heading.

Filtering bin content

Premiere Pro has built-in search tools to help you find your media. Even if you’re 
using nondescriptive original clip names assigned in-camera, you can search for 
clips based on a number of factors, such as frame size or file type.

At the top of the Project panel, you can type in the Filter Bin Content box to display 
only clips with names or metadata matching the text you enter. This is a quick way 
to locate a clip if you remember its name (or even part of its name). Clips that don’t 
match the text you enter are hidden, and clips that do match are revealed, even if 
they are inside a closed bin.

E	Tip:  You can scroll 
the Project panel view 
up and down using the 
scroll wheel on your 
mouse.

P	Note:  When you 
scroll to the right in the 
Project panel, Premiere 
Pro always maintains 
the clip names on the 
left so you know which 
clips you’re seeing 
information about.

P	Note:  You may need 
to drag a divider to 
expand the width of a 
column before you can 
see its sorting order 
arrow.

P	Note:  Graphic and 
photo files such as 
Photoshop PSD, JPEG, 
and Illustrator AI files 
import with a default 
frame duration you set 
in Preferences > General 
> Still Image Default 
Duration.
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Try this now.

1	 Click in the Filter Bin Content box, and type joh.

Premiere Pro displays only clips with the letters 
joh in the name or in the metadata. Notice that 
the name of the project is displayed above the text 
entry box, along with “(filtered).”

2	 Click the X on the right of the Find box to clear your search.

3	 Type psd in the box.

Premiere Pro displays only clips that have the letters psd in their name or metadata. 
In this case, it’s the Theft_Unexpected title you imported earlier as both a flattened 
image and a layered image—these are both Photoshop PSD files. Using the Filter 
Bin Content box in this way, you can search for particular types of files.

Be sure to click the X on the right of the Filter Bin Content box to clear your filter 
when you have found the clips you want.

Using advanced Find

Premiere Pro also has an advanced Find option. To learn about it, you can import a 
couple more clips.

Using any of the methods described in Lesson 3, import these items:

•	 Seattle_Skyline.mov from the Assets/Video and Audio Files/General Views 
folder.

•	 Under Basket.MOV from the Assets/Video and Audio Files/Basketball folder.

At the bottom of the Project panel, click the Find button (   ). Premiere Pro displays 
the Find panel, which has more advanced options for locating your clip.

P	Note:  The name bin 
comes from film editing. 
The Project panel is 
also effectively a bin; it 
can contain clips and 
functions exactly like 
any other bin.
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You can perform two searches at once with the advanced Find panel. You can 
choose to display clips that match both search criteria or either search criterion. 
For example, you could do either of the following:

•	 Search for a clip with the words dog AND boat in its name.

or

•	 Search for a clip with the word dog OR boat in its name.

Then choose a few options.

•	 Column: This option lets you select from the available headings in the Project 
panel. When you click Find, Premiere Pro will search using only the heading 
you select.

•	 Operator: This option gives you a set of standard search options. Use this menu 
to choose whether you want to find a clip that contains, matches exactly, begins 
with, or ends with whatever you search for.

•	 Match: Choose All to find a clip with both your first and your second 
search text. Choose Any to find a clip with either your first or your second 
search text.

•	 Case Sensitive: Selecting this option tells Premiere Pro whether you want your 
search to exactly match the uppercase and lowercase letters you enter.

•	 Find What: Type your search text here. You can add up to two sets of 
search text.

When you click Find, Premiere Pro highlights a clip that matches your search 
criteria. Click Find again, and Premiere Pro highlights the next clip that matches 
your search criteria. Click Done to exit the Find dialog box.

Working with bins
Bins allow you to organize clips by dividing them into groups.

Just like folders on your hard drive, you can have multiple bins inside other bins, 
creating a folder structure as complex as your project 
requires.

There’s an important difference between bins and the 
folders on your storage drive: Bins exist only in your 
Premiere Pro project file to organize clips. You won’t 
find individual folders representing project bins on your 
storage drive.



70  Lesson 4 O rganizing Media

Creating bins
Let’s create a bin.

1	 Click the New Bin button (   ) at the bottom of the Project panel.

Premiere Pro creates a new bin and automatically highlights the name, ready for 
you to rename it. It’s a good habit to name bins as soon as you create them.

2	 You have already imported some clips from a film, so let’s give them a bin. Name 
the new bin Theft Unexpected.

3	 You can also create a bin using the File menu. Let’s do this now: Make sure the 
Project panel is active and choose File > New > Bin.

4	 Name the new bin PSD Files.

5	 You can also make a new bin by right-clicking a blank area in the Project panel 
and choosing New Bin. Try this now.

6	 Name the new bin Illustrator Files.

One of the quickest and easiest ways to create a new 
bin for clips you already have in your project is to 
drag and drop the clips onto the New Bin button at 
the bottom of the Project panel.

7	 Drag and drop the clip Seattle_Skyline.mov onto the 
New Bin button.

8	 Name the newly created bin City Views.

9	 Make sure the Project panel is active but no existing 
bins are selected. Press the keyboard shortcut 
Control+B (Windows) or Command+B (Mac OS) to 
make another bin.

10	Name the bin Sequences.

If your Project panel is set to List view, bins are 
displayed in alphabetical order among the clips.

Managing media in bins
Now that you have some bins, let’s put them to use. As you move clips into bins, 
use the disclosure triangles to hide their contents and tidy up the view.

1	 Drag the clip Brightlove_film_logo.ai into the Illustrator Files bin.

2	 Drag Theft_Unexpected.psd into the PSD Files bin.

3	 Drag the Theft_Unexpected_Layered bin (created automatically when you 
imported the layered PSD file as individual layers) into the PSD Files bin.

P	Note:  To rename a 
bin, select it and press 
the Enter key.

P	Note:  It can be 
difficult to find a blank 
part of the Project panel 
to click when it is full of 
clips. Try clicking just 
to the left of the icons, 
inside the panel.

P	Note:  When you 
import an Adobe 
Photoshop file with 
multiple layers and 
choose to import as a 
sequence, Premiere Pro 
automatically creates 
a bin for the layers and 
their sequence.
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4	 Drag the clip Under Basket.MOV into the City Views bin. You may need to 
resize the panel or switch it to full-screen to see both the clip and the bin.

5	 Drag the sequence called First Sequence into the Sequences bin.

6	 Drag all the remaining clips into the Theft Unexpected bin.

You should now have a nicely organized Project panel, with each kind of clip in 
its own bin.

Notice that you can also copy and paste clips to make 
extra copies if this suits your organizational system. You 
have a Photoshop document that might be useful for the 
Theft Unexpected content. Let’s make an extra copy.

7	 Click the disclosure triangle for the PSD Files bin to display the contents.

8	 Right-click the Theft_Unexpected.psd clip and choose Copy.

9	 Click the disclosure triangle for the Theft Unexpected bin to display the contents.

10	Right-click the Theft Unexpected bin and choose Paste.

Premiere Pro places a copy of the clip in the Theft Unexpected bin.

Finding your media files
If you’re not sure where a media file is on your hard drive, right-click the clip in the 
Project panel and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac OS).

Premiere Pro will open the folder on your hard drive that contains the media file and 
highlight it. This can be useful if you are working with media files stored on multiple 
hard drives or if you have renamed your clips in Premiere Pro.

Changing bin views
Although there is a distinction between the Project panel and bins, they have the 
same controls and viewing options. For all intents and purposes, you can treat the 
Project panel as a bin; many Premiere Pro editors use the terms bin and Project 
panel interchangeably.

Bins have two views. You choose between them by clicking the List View button (   ) 
or Icon View button (   ) at the bottom left of the Project panel.

•	 List view: This view displays your clips and bins as a list, with a significant 
amount of metadata displayed. You can scroll through the metadata and use it 
to sort clips by clicking column headers.

•	 Icon view: This view displays your clips and bins as thumbnails you can 
rearrange and play back.

E	Tip:  You can 
make Shift-click and 
Control-click (Windows) 
or Command-click (Mac 
OS) selections in the 
Project panel, just as 
you can with files on 
your hard drive.

P	Note:  When you 
make copies of clips, 
you are not making 
copies of the media 
files they are linked to. 
You can make as many 
copies as you like of a 
clip in your Premiere Pro 
project. Those copies 
will all link to the same 
original media file.
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The Project panel has a Zoom control, which changes the size of the clip icons or 
thumbnails.

1	 Double-click the Theft Unexpected bin to open it in its 
own floating panel.

2	 Click the Icon View button on the Theft Unexpected bin to display thumbnails 
for the clips.

3	 Try adjusting the Zoom control.

Premiere Pro can display large thumbnails to make browsing and selecting your 
clips easier.

You can also apply various kinds of sorting to clip thumbnails in Icon view by 
clicking the Sort Icons (   ) menu.

4	 Switch to List view.

5	 Try adjusting the Zoom control for the bin.

When you’re in List view, it doesn’t make that much 
sense to zoom, unless you turn on the display of 
thumbnails in this view.

6	 Click the panel menu (on the panel tab) and choose 
Thumbnails.

Premiere Pro now displays thumbnails in List view, 
as well as in Icon view.

7	 Try adjusting the Zoom control.

The clip thumbnails show the first frame of the media. In some clips, the first 
frame will not be particularly useful. Look at the clip HS Suit, for example. The 
thumbnail shows a clapperboard, but it would be useful to see the character.

P	Note:  You can also 
change the font size 
in the Project panel 
by clicking the panel 
menu and choosing 
Font Size. This is 
particularly useful if 
you are working on a 
high-resolution screen. 
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8	 Switch to Icon view.

In this view, you can hover the mouse cursor over a clip thumbnail to see a 
preview of the clip.

 9	 Hover the mouse cursor over the HS Suit clip. Move the mouse until you find a 
frame that better represents the shot.

10	While the frame you have chosen is displayed, press the I key.

I is the keyboard shortcut for Mark In, a command that sets the beginning of 
a selection when choosing part of a clip that you intend to add to a sequence. 
The same selection also sets the poster frame for a clip in a bin.

11	Switch to List view.

Premiere Pro shows your newly selected frame as the thumbnail for this clip.

12	Use the panel menu (on the panel tab) to turn off thumbnails in List view.

13	Close the Theft Unexpected bin.

Search bins

When using the Filter Bin Content box to display specific clips, you have the option 
to create a special kind of virtual bin, called a Search bin.

After typing in the Filter Bin Content box, click the Create New Search Bin button 
(   ).

Search bins appear in the Project panel automatically (not inside other bins). They 
display the results of a search performed when using the Filter Bin Content box.

You can rename search bins 
and place them in other bins.

The contents of a Search bin will update dynamically, so if you add new clips to a 
project that meet the search criteria, they’ll appear in the search bin automatically. 
This can be a fantastic time-saver when working with documentary material that 
changes over time as you obtain new footage.

Assigning labels
Every item in the Project panel has a label color. In List view, the Label column 
shows the label color for every clip. When you add clips to a sequence, they are 
displayed in the Timeline panel with this label color.

P	Note:  In addition 
to hovering the mouse 
cursor over a clip 
thumbnail, you can 
click to select the clip, 
which will reveal a small 
timeline control under 
the thumbnail. You can 
use this timeline to view 
the contents of the clip.

E	Tip:  When you’ve 
finished using the Filter 
Bin Content box, be 
sure to click the X on 
the right side to clear 
the filter.



74  Lesson 4 O rganizing Media

Let’s change the color for a title.

1	 Right-click Theft_Unexpected.psd and choose Label > Forest.

You can change label colors for multiple clips in a single step by selecting them 
and then right-clicking the selected clips to choose another label color.

2	 Press Control+Z (Windows) or Command+Z (Mac OS) to change the  
Theft_Unexpected.psd label color back to Lavender.

When you add a clip to a sequence, Premiere Pro creates a new instance, or copy of 
that clip. You’ll have one copy in the Project panel and one copy in the sequence.

By default, when you change the label color for a clip in the Project panel or 
rename a clip, it won’t update copies of the clip in sequences.

You can change this by choosing File > Project Settings > General and enabling the 
option to display the project item name and label color for all instances.

Changing the available label colors
You can assign up to eight available colors as labels to items in your project. There 
are also eight types of items that label colors can be assigned to, which means there 
aren’t any spare label colors.

If you choose Edit > Preferences > Label Colors (Windows) or Premiere Pro > 
Preferences > Label Colors (Mac OS), you’ll see the list of colors, each with a color 
swatch. You can click the color swatch to change the color.

If you select Label Defaults in the preferences, you can choose different default 
labels for each kind of item in your project.

Changing names
Because clips in your project are separate from the media files they link to, you can 
rename items in Premiere Pro, and the names of your original media files on the 
hard drive are left untouched. This makes renaming clips safe to do.

1	 Open the PSD Files bin.

2	 Right-click the clip Theft_Unexpected.psd and choose Rename.

3	 Change the name to TU Title BW.
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4	 Right-click the newly renamed clip, TU Title BW, and choose Reveal in Explorer 
(Windows) or Reveal in Finder (Mac OS).

The file is displayed. Notice that the original filename has not changed. It’s helpful 
to be clear about the relationship between your original media files and the clips 
inside Premiere Pro because it explains much of the way the application works.

Customizing bins
When set to List view, the Project panel displays a number of clip information 
headings. You can easily add or remove headings. Depending on the clips you have 
and the types of metadata you are working with, you might want to display or hide 
different headings.

1	 Open the Theft Unexpected bin.

2	 Click the panel menu and choose Metadata Display. The Metadata Display panel 
opens.

The Metadata Display panel allows you to choose any kind of metadata to use 
as a heading in the List view of the Project panel (and any bins). All you have 
to do is select the check box for the kind of information you would like to be 
included.

3	 Click the disclosure triangle for Premiere Pro Project Metadata to show those 
options.

4	 Select the Media Type check box.

5	 Click OK.

Media Type is now added as a heading for the Theft Unexpected bin but not for 
any other bins. To make this kind of change to every bin in one step, use the panel 
menu in the Project panel rather than in an individual bin.

P	Note:  When you 
change the name of 
a clip in Premiere Pro, 
the new name is stored 
in the project file. Two 
project files could 
easily have different 
names representing the 
same clip.
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Some of the headings are for information only, while others can be edited directly 
in the bin. The Scene heading, for example, allows you to add a scene number for 
each clip.

Notice that if you enter a number for a scene and then press the Enter key, 
Premiere Pro activates the next scene box. This way, you can use the keyboard 
to quickly enter information about several clips, jumping from one box to the 
next.

Having multiple bins open at once
Every bin panel behaves in the same way, with the same options, buttons, and 
settings. By default, when you double-click a bin, it opens in a floating panel. 

You can change this in Preferences.

To change the options, choose Edit > Preferences > General (Windows) or Premiere 
Pro > Preferences > General (Mac OS).

The options let you choose what will happen 
when you double-click, double-click with the 
Control (Windows) or Command (Mac OS) key, 
or double-click with the Alt (Windows) or Option 
(Mac OS) key.

Monitoring footage
The greater part of video editing is spent watching clips and making creative 
choices about them. It’s important to feel comfortable browsing media.

Premiere Pro has multiple ways of performing common tasks such as playing video 
clips. You can use the keyboard, click buttons with your mouse, or use an external 
device like a jog/shuttle controller.

1	 Double-click the Theft Unexpected bin to open it.

2	 Click the Icon View button at the lower-left corner of the bin.

3	 Drag your mouse, without clicking, across any of the images in the bin.

Premiere Pro displays the contents of the clip as you drag. The left edge 
of the thumbnail represents the beginning of the clip, and the right edge 
represents the end. In this way, the width of the thumbnail represents the 
whole clip.

P	Note:  Several 
useful bin headings are 
displayed by default, 
including the Good 
check box. Select this 
box for clips you prefer, 
and then click the 
heading to sort selects 
from unwanted content.
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4	 Select a clip by clicking it once. Hover scrubbing is now turned off, and a mini 
scroll bar appears at the bottom of the thumbnail. Try dragging through the clip 
using the scroll bar.

When a clip is selected, you can use the J, K, and L keys on your keyboard to 
perform playback, just as you can in the Media Browser.

•	 J: Play backward

•	 K: Pause

•	 L: Play forward

5	 Select a clip and use the J, K, and L keys to play the thumbnail. Be sure to click 
the clip only once; if you double-click, the clip will open in the Source Monitor.

When you double-click a clip, not only does Premiere Pro display the clip in the 
Source Monitor, but it adds it to a list of recent clips.

6	 Double-click to open four or five clips from the Theft Unexpected bin in the 
Source Monitor.

7	 Click the panel menu, on the tab at the top of the Source Monitor, to browse 
between your recent clips.

E	Tip:  If you press 
the J or L key multiple 
times, Premiere Pro will 
play the video clips at 
multiple speeds.
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8	 Click the Zoom menu at the bottom of the Source Monitor. By default, this 
is set to Fit, which means Premiere Pro will display the whole 
frame, regardless of the original size. Change the setting to 100%.

These clips are high-resolution, and they are probably much bigger than your 
Source Monitor. You’re likely to have scroll bars at the bottom and on the right 
of your Source Monitor now, so you can view different parts of the image.

The benefit of viewing with Zoom set to 100% is that you see every pixel of the 
original video, which is useful for checking the quality.

9	 Set the Zoom menu back to Fit.

E	Tip:  Notice that you 
have the option to close 
a single clip or close 
all clips, clearing the 
menu and the monitor. 
Some editors like to 
clear the menu and 
then open several clips 
that are part of a scene 
by selecting them all in 
the bin and dragging 
them into the Source 
Monitor together. They 
can then use the Recent 
Items menu to browse 
only the clips from that 
selection.
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Playback resolution

If you have an older or slower processor or are working with large frame sizes such 
as Ultra High-Definition (4K or above), your computer may struggle to play back all 
the frames of your video clips. The clips will play with the correct timing, but some 
frames may not be displayed.

To work with a wide variety of computer hardware configurations, from powerful 
desktop workstations to lightweight portable laptops, Premiere Pro can lower the 
playback resolution to make playback smoother.

The default resolution is 1/2. You can switch the playback resolution 
as often as you like, using the Select Playback Resolution menu on 
the Source Monitor and Program Monitor panels.

Some lower resolutions are available only when working with particular media 
types.

Timecode information

At the bottom left of the Source Monitor, a timecode display shows the current 
position of the playhead in hours, minutes, seconds, and frames (00:00:00:00). 

For example, 00:15:10:01 would be 0 hours, 15 minutes, 10 seconds, and 1 frame.

Note that this is based on the original timecode for the clip, which probably does 
not begin at 00:00:00:00.

At the bottom right of the Source Monitor, a timecode display shows the duration 
of your clip. By default, this shows the whole clip duration, but later you’ll add 
special marks to make a partial selection. When you do, that duration shown will 
change accordingly.

Safe margins

Television monitors often crop the edges of the picture to achieve a clean edge. 
If you’re producing video for a cathode ray tube (CRT) monitor, click the Settings 
menu (   ) at the bottom of the Source Monitor and choose Safe Margins. Premiere 
Pro displays white outlines over the image.

The outer box is the action-safe zone. Aim to keep important action inside this 
box so that when the picture is displayed, edge cropping does not hide what is 
going on.

The inner box is the title-safe zone. Keep titles and graphics inside this box 
so that even on a badly adjusted display, your audience will be able to read 
the words.
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Premiere Pro also has advanced overlay options that can be configured to display 
useful information in the Source Monitor and Program Monitor. To enable or 
disable overlays, go to the monitor Settings (   ) menu and choose Overlays.

You can access the settings for the overlays and safe margins by clicking the 
monitor Settings menu and choosing Overlay Settings > Settings.

Click the Settings button at the bottom of the Source Monitor and choose Safe 
Margins to hide them.

Using essential playback controls
Let’s look at the playback controls.

1	 Double-click the shot Excuse Me in the Theft Unexpected bin to open it in the 
Source Monitor.

Step  
Forward 1 Frame

Play
Step  

Back 1 FrameNavigator

Time RulerPlayhead

2	 At the bottom of the Source Monitor, you’ll find a blue playhead marker. 
Drag it along the bottom of the panel to view different parts of the clip. You 
can also click wherever you want the playhead to go, and it will jump to 
that spot.
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3	 Below the time ruler and the playhead, there’s a scroll bar that doubles as a 
Zoom control. Drag one end of the scroll bar to zoom in on the clip navigator.

Drag here Drag here

4	 Click the Play/Stop button to play the clip. Click it again to stop playback. You 
can also use the spacebar to play and stop playback.

5	 Click the Step Back 1 Frame and Step Forward 1 Frame buttons to move 
through the clip one frame at a time. You can also use the Left Arrow and Right 
Arrow keys on your keyboard.

6	 Try using the J, K, and L keys to play your clip.

Customizing the monitors
To customize the way a monitor displays video, click the Settings menu (   ).

The Source Monitor and Program Monitor have the same options. You can view an 
audio waveform, which shows amplitude over time, and if your video has fields, you 
can choose which fields are shown.

Make sure Composite Video is selected in this menu.

You can also switch between viewing the clip audio waveform and the video by 
clicking the Drag Video Only (   ) or Drag Audio Only (   ) icon. These icons 
are used when editing clips into a sequence but also provide this useful display 
shortcut.

You can change the buttons displayed at the bottom of the Source Monitor and 
Program Monitor.

1	 Click the Button Editor (   ) at the bottom right of the Source Monitor.

A special set of buttons appears on a floating panel.

2	 Drag the Loop button (   ) from the floating panel to a spot to the right of the 
Play button on the Source Monitor and click OK.
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3	 Double-click the Excuse Me clip in the Theft Unexpected bin to open it in the 
Source Monitor if it isn’t open already.

4	 Click the Loop button to enable it, and then play the video using the spacebar 
or the Play button on the Source Monitor. Stop the playback when you’ve seen 
enough.

With Loop turned on, Premiere Pro continuously repeats playback of a clip or 
sequence.

5	 Click the Play button to play the clip. Click it again to stop playback. You can 
also use the spacebar to play and stop playback.

6	 Click the Step Back 1 Frame and Step Forward 1 Frame buttons to move 
through the clip one frame at a time. You can also use the Left Arrow and Right 
Arrow keys on your keyboard.

Modifying clips
Premiere Pro uses metadata associated with clips to know how to play them back. 
Occasionally, this metadata will be wrong, and you’ll need to tell Premiere Pro how 
to interpret a clip.

You can change the interpretation of clips for one file or multiple files in a single 
step. All clips you have selected are affected by changes to interpretation.

Adjusting audio channels
Premiere Pro has advanced audio management features. You can create complex 
sound mixes and selectively target output audio channels with original clip audio. 
You can produce mono, stereo, 5.1, and even 32-channel sequences with precise 
control over the routing of audio channels.

If you’re just starting out, you’ll probably want to produce sequences mastered in 
stereo using mono or stereo clips. In this case, the default settings are most likely 
what you need.

When recording audio with a professional camera, it’s common to have one 
microphone record onto one audio channel and a different microphone record 
onto another audio channel. These are the same audio channels that would be used 
for regular stereo audio, but they now contain completely separate sound.

Your camera adds metadata to the audio to tell Premiere Pro whether the sound 
is meant to be mono (separate audio channels) or stereo (channel 1 audio and 
channel 2 audio combined to produce the complete stereo sound).

You can tell Premiere Pro how to interpret audio channels when new media files are 
imported by choosing Edit > Preferences > Audio > Default Audio Tracks (Windows) 
or Premiere Pro > Preferences > Audio > Default Audio Tracks (Mac OS).
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If the setting was wrong when you imported your clips, it’s easy to tell Premiere Pro 
how to correctly interpret the audio channels.

1	 Right-click the Reveal clip in the Theft Unexpected bin and choose Modify > 
Audio Channels.

When the Preset menu is set to Use File, as it is here, Premiere Pro will use 
the file’s metadata to identify the channel format for the audio. In this case, 
it’s a stereo clip, so the Left and Right channels of the Source clip (described 
at the top of the selection matrix) are both assigned to a single clip for editing 
(described on the left).

When you add this clip to a sequence, it will appear as one video clip and one 
audio clip.

2	 Click the Preset menu and change it to Mono.

Premiere Pro switches the Channel Format menu to Mono. You’ll see that the 
Left and Right source channels are now linked to two separate clips.

This means that when you add the clip to a sequence, each audio channel 
will go on a separate track, as separate clips, allowing you to work on them 
independently.

3	 Click OK.
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A few tips on audio clip 
channel interpretation
Here are some things to keep in mind when working with audio clip channel 
interpretation:

•	 In the Modify Clip dialog box, every available audio channel will be listed.

•	 You can override the original file audio channel interpretation. This will mean a 
different type of audio track may be needed in a sequence.

•	 The list on the left (which may be as short as one clip) shows how many clips will 
be added to a sequence when using this audio.

•	 Use the check boxes to choose which source audio channels are included in 
each sequence audio clip. This means you can easily combine multiple source 
audio channels into a single sequence clip or separate them into different clips 
in any way that works for your project.

Merging clips
It’s quite common for video to be recorded on a camera with relatively low-quality 
audio while high-quality sound is recorded on a separate device. When working 
this way, you’ll want to combine the high-quality audio with the video by merging 
them.

The most important factor when merging video and audio files in this way is 
synchronization. You will either manually define a sync point—like a clapperboard 
mark—or allow Premiere Pro to sync your clips automatically based on their 
original timecode information or audio.

If you choose to sync clips using audio, Premiere Pro will analyze both the 
in-camera audio and the separately captured sound and match them up.

•	 If you don’t have matching audio in the clips you are merging, you can manually 
add a marker. If you’re adding a mark, place it on a clear sync point like a 
clapperboard.

•	 Select the camera clip and the separate audio clip. Right-click either item and 
choose Merge Clips.

•	 Under Synchronize Point, choose your sync point, and click OK.

A new clip is created that combines the video and the “good” audio in a single item.

Interpreting video footage
For Premiere Pro to play back a clip correctly, it needs to know the frame rate 
for the video, the pixel aspect ratio (the shape of the pixels), and, if your clip is 
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interlaced, the order in which to display the fields. Premiere Pro can find out this 
information from the file’s metadata, but you can change the interpretation easily.

1	 Import RED Video.R3D from the Lessons/Assets/Video and Audio Files/
RED folder. Double-click the clip to open it in the Source Monitor. It’s full 
anamorphic widescreen, which is a little too wide for this project.

2	 Right-click the clip in the Project panel and choose Modify > Interpret Footage.

The option to modify audio channels is unavailable because this clip has no 
audio.

3	 Right now, the clip is set to use the pixel aspect ratio setting from the file: 
Anamorphic 2:1. This means the pixels are twice as wide as they are tall.

4	 Use the Conform To menu to change the Pixel Aspect Ratio setting to DVCPRO 
HD (1.5). Then click OK.

From now on, Premiere Pro will interpret the clip as having pixels that are 
1.5 times wider than they are tall. This reshapes the picture to make it standard 
16:9 widescreen. You can see the result in the Source Monitor.

This won’t always work—in fact, it often introduces unwanted distortion—but 
it can provide a quick fix for mismatched media (a common problem for news 
editors).

Working with raw files
Premiere Pro has special settings for .R3D files created by RED cameras, .ari files 
created by ARRI cameras, and several others. These files are similar to the Camera 
RAW format used by professional digital single-lens reflex (DSLR) still cameras. 

RAW files always have a layer of interpretation applied to them in order to view 
them. You can change the interpretation at any time without impacting playback 
performance. This means you can make changes, for example, to the colors in a 
shot without requiring any extra processing power. You could achieve a similar 
result using a special effect, but your computer would have to do more work to play 
the clip.

The Effect Controls panel gives access to controls for clips in sequences and in the 
Project panel. You can use it to change the interpretation of RAW media files.

1	 Double-click the RED Video.R3D clip to open it in the Source Monitor.

2	 Using the panel tab, drag the Effect Controls panel over the Program Monitor so you 
can see both the Source Monitor and the Effect Controls panel at the same time.
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Because the RED Video.R3D clip is displayed in the Source Monitor, the Effect 
Controls panel now shows the RED Source Settings options for that clip, which 
change the way the RAW media is interpreted.

In many ways, this is a color correction tool, with automatic white balance and 
individual adjustments for the red, green, and blue values.

3	 Scroll down to the end of the list, where you’ll find Gain settings. Increase the 
Red gain to about 1.5. You can click the disclosure triangle to reveal a slider 
control, drag the blue number directly, or click and type over the number.

4	 Take another look at the clip in the Source Monitor.

The picture has updated. If you had already edited this clip into a sequence, it 
would update in the sequence too.

For more information about working with RED media, go to http://helpx.adobe.
com/premiere-pro/compatibility.html.

Different RAW media files will give different RED Source Settings options in the 
Effect Controls panel.

http://helpx.adobe.com/premiere-pro/compatibility.html
http://helpx.adobe.com/premiere-pro/compatibility.html
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Review questions
1	 How do you change the List view headings displayed in the Project panel?

2	 How can you quickly filter the display of clips in the Project panel to make finding a 
clip easier?

3	 How do you create a new bin?

4	 If you change the name of a clip in the Project panel, does it change the name of the 
media file it links to on your hard drive?

5	 What keys can you use to play back video and sound clips?

6	 How can you change the way clip audio channels are interpreted?

Review answers
1	 Click the panel menu for the Project panel and choose Metadata Display. Select the 

check box for any heading you want to appear.

2	 Click the Filter Bin Content box and start typing the name of the clip you are looking 
for. Premiere Pro hides any clips that don’t match and displays those that do.

3	 You have several options: Click the New Bin button at the bottom of the Project panel, 
go to the File menu and choose New > Bin, right-click a blank area in the Project panel 
and choose New Bin, or press Control+B (Windows) or Command+B (Mac OS). You 
can also drag and drop clips onto the New Bin button on the Project panel.

4	 No. You can duplicate, rename, or delete clips in your Project panel, and nothing will 
happen to your original media files.

5	 The spacebar plays and stops. J, K, and L can be used like a shuttle controller to play 
backward and forward, and the arrow keys can be used to move one frame backward 
or one frame forward. 

6	 In the Project panel, right-click the clip you want to change and choose Modify > 
Audio Channels. Choose the correct option (usually by selecting a preset) and 
click OK.
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Numbers

3D space, manipulating clips in, 218–219
8-bit video, 322–323, 351
32-bit color effects, using with video, 292

A

AAC Audio format, exporting to, 438
AAF (Advanced Authoring Format),  

exporting to, 447
A/B editing mode, using with transitions, 

153–158
accelerated effects, using with video, 292
adjustment layers, using with video effects, 

295–298
Adobe After Effects

converting compositions to clips, 418
Roto Brush tool, 380
sending clips to, 298–300

Adobe Audition
removing background noise, 278–280
sending audio to, 252

Adobe components
After Effects, 6–7
Audition, 6–7
Dynamic Link, 6–7
Encore, 6
Illustrator, 6
Media Encoder, 6
Photoshop, 6
Prelude, 6–7
SpeedGrade, 6

Adobe Illustrator files
Editor Original option, 56
importing, 55–56

Adobe Media Encoder. See also exporting
adding stand-alone files, 444
After Effects compositions, 444
configuring exports, 439–441
export effects, 441
file format for export, 437–439
file formats, 442
importing sequences, 444

modifying queues, 445
Output panel, 441–442
queuing exports, 442–444
Source panel, 441–442
watch folders, 445

Adobe Photoshop
graphics and titles, 402–403
image tips, 55
importing, 53–54

Adobe Prelude
adding markers with, 129
importing from, 47–48

Adobe SpeedGrade, sending sequences to, 
356–358

ADV and DV capture, 27
AES and XLR audio, using with professional 

decks, 453
After Effects

converting compositions to clips, 418
Roto Brush tool, 380
sending clips to, 298–300

AIFF format, exporting to, 438
alignment, choosing for video  

typography, 393
alpha, preserving, 418
alpha channels

explained, 363–364, 366
transparencies, 370–371

Alt key. See keyboard shortcuts
Anchor Point setting, choosing for  

Motion control, 197
Anchor presets, using, 312
Andrea Sweeney NYC clip, 453
Animated GIF format, exporting to, 439
animating

clip size changes, 208–210
positions of layers, 201–203

anti-aliasing method, using with video 
transitions, 150

Anti-flicker Filter setting, choosing for  
Motion control, 197

application preferences, 15
Area Type tool, using, 398
.ari files, 85

Index
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AS-11 format, exporting to, 438
assets

finding in Project panel, 66–69
finding with Media Browser, 

50–52
importing, 45–46

audio. See also sound; volume
clip vs. track keyframes, 256
faders, 257
master track output, 240–241
monitoring, 245
normalizing, 251–252
occurrence of hum, 277
removing background noise, 

278–280
sending to Adobe Audition CC, 

252
signal-to-noise ratio, 242
smoothing volume between 

keyframes, 256
split edits, 253
uses of, 238
voice-over “scratch track,” 

247–248
volume adjustments, 248–252

audio channels
adjusting, 82–83
explained, 241
tips, 84

audio characteristics
amplitude, 247
frequency, 246
phase, 247

Audio Clip Mixer
displaying in Editing workspace, 

9, 11
using, 256–257

audio clips. See also clips
changing volume, 255
measuring time for, 25–27
selecting, 134

audio conform files, including, 
417–418

Audio Display Format, 26–27
audio editing, 4
Audio Effects, using with video,  

290
audio gain, adjusting, 250–251
audio levels

adjusting for clips, 254–257
explained, 242

Audio Master Meters, displaying in 
Editing workspace, 9

audio master setting, 241
audio meters

adding to tracks, 239–240

displaying for EQ effect, 270
setting, 242

audio noise
Highpass and Lowpass effects, 

272–273
Loudness Radar, 281–283
Multiband Compressor effect, 

273–277
Notch effect, 277

Audio Plug-in Manager, 292
audio samples, viewing, 243
audio tracks

types of, 39
working with, 245

audio transitions. See also transitions
applying, 160–161
creating crossfades, 159

audio waveforms, viewing, 81, 243–
245, 251

Audio workspace
switching to, 238–239
working in, 239–240

Audition
removing background noise, 

278–280
sending audio to, 252

Auto Bézier keyframe interpolation, 
309

Auto Save files
preferences, setting, 15
storing, 28

AVI format, exporting to, 439
Avid Media Composer projects, 

importing, 32–33

B

background noise, removing, 
278–280

backup files, saving automatically, 15
Basic 3D effect, using with clips, 

218–219
bass, adding to sound, 263
Batch capture option, using in File 

menu, 415
bevels, adding, 214
Bézier 

curve controls, 196
interpolation, 211, 309

Bike Race multicamera footage,  
453

bin content, filtering, 67–68
bin headings, displaying, 76
bins

assigning labels, 73–74
creating, 70

customizing, 75–76
explained, 69
versus folders, 69
Icon view, 71, 73
List view, 71–72
managing media in, 70–71
Metadata Display panel, 75
opening multiple, 76
in Project panel, 64
renaming, 70
renaming clips, 74–75
Search bin, 73
views, 71–73

black-and-white effects, using, 340
blend mode

combining layers based on, 
369–370

explained, 367
BMP format, exporting to, 439
cache. See media cache 
brightness slider, using, 15

C

capture devices, form factors, 58
Capture Format settings, 27
CC Libraries downloads, 29–30
Chapter Marker, explained, 125
chromakey composition

making, 372
Ultra Key effect, 373–376

clip duration, changing, 170–172
clip interpretation, changing, 90
clip navigator, zooming in on, 81
clip position, changing, 201–203
Clip projects, importing, 31
clip ranges, selecting in Source 

Monitor, 93–95
clip rotation, changing, 201–203
clip size

animating changes to, 208–210
changing, 201–203, 206–208

clip speed, changing, 175
clipboard, using, 138
clips. See also audio clips; subclips; 

video clips
adding markers to, 127–128
adding to multicamera source 

sequences, 227–229
adding to Timeline, 118–119
adding to tracks, 99
adjusting audio channels, 82–83
caution about dropping, 137
closing, 78
copying, 134
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creating instances of, 74
disabling and reenabling, 

140–141
displaying in Editing workspace, 

9
dragging, 136
dragging and dropping, 118
editing, 21
editing into sequences, 121
explained, 20
finding in Timeline, 130
isolating for selection, 161
linking and unlinking, 135
loading in Source Monitor, 91–92
making copies of, 71
making offline, 415–416
making online, 415–416
manipulating in 3D space, 

218–219
masking, 376–379
merging, 84
navigating with markers, 128
nudging, 136–137
rearranging in sequences, 

137–138
rejoining, 135
Remove Unused option, 424
renaming, 74–75
replacing, 175–179
representing in thumbnails, 76
scaling, 99
searching in sequences, 130
selecting, 132–134
sorting in icon view, 109
splitting, 134–135

closed captioning, using, 449–450
codecs

choosing, 435–436
explained, 36
GoPro CineForm, 420, 436

collaboration, managing, 426–427
color balance

Lumetri color wheels, 352–354
primary color correction, 

349–352
white balance, 348–349

color correction, 4, 324, 341–343
evaluating, 347
Video Limiter effect, 343–344

color effects
Gaussian Blur, 354
Lumetri looks, 355
Solarize, 354

color grading, 324
color removal or replacement, 

340–341

Color workspace, 324–325
coloring effects
color-oriented workflow, following, 

323–324
colors

choosing for video typography, 
388

broadcast-safe, 400
choosing for titles, 400
Lumetri Color panel, 325–330

Command key. See keyboard 
shortcuts

Comment Marker, explained, 125
component video, using with 

professional decks, 453
compositing techniques

alpha channels, 363–364
keying, 363
for shooting video, 365–366
terminology, 366–367

Constant Gain crossfade, 159
Constant Power crossfade, 159
Continuous Bézier keyframe 

interpolation, 309
copies of clips, making, 71
copying

clips, 134
files, 418–419
media, 419

crawling text, 408–409
credits, writing, 408
crossfades, creating, 159
Ctrl key. See keyboard shortcuts

D

dB (decibel) scale, 242
delay, adding to sound, 264
deleting segments, 138–141
Desert clip, 453
dialogue, locating, 244
digital video workflow

enhancing, 4–5
incorporating components into, 

5–6
process, 3–4
scenarios, 6–7

disk space, calculating, 418
dissolves, positioning start times of, 

156
DNxHD MXF OP1a format

explained, 419
exporting to, 438

downloading media files, 29–30
DPX format, exporting to, 438
drop shadows, adding, 213–214

dropping frames, 22
duration of clips. See clip duration
DV and HDV capture, 27
DV deck, recording to, 451–452
Dynamic Link

features, 53
using for media management, 428

dynamic trimming, performing, 
191–192

E

Ease In and Ease Out 
adding to motion, 211–213
keyframe interpolation, 309

edit points, using with transitions, 
146–147

editing clips into sequences, 121
editing commands

insert edit, 105–107
overwrite edit, 105
storyboard editing, 108–111
three-point editing, 107

editing techniques. See also trimming
changing playback speed, 

168–174
Fit to Fill, 168
four-point editing, 166
nesting sequences, 179–180
over-cranking, 170
replace edits, 176–178
replacing clips and footage, 

175–179
ripple edits, 182–184
rolling edits, 184, 253
sliding edits, 184–185

editing to markers, automating, 
128–129

Editing workspace
accessing, 7–8
customizing, 12–14
default, 9
displaying panels, 9
layout, 8–12
resetting, 8
user interface, 9

edits, making with four marks, 107. 
See also sequences

EDLs (edit decision lists), working 
with, 447–448

Effect controls
changing parameters in, 153–155
displaying in Editing workspace, 

9–11
Morph Cut effect, 155–156
resizing, 154
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Show/Hide Timeline View 
button, 154

using, 13–14
using with raw files, 85–86

effect presets
saving, 310–312
using, 310

effects
Clip Name, 314–315
image stabilization, 312–313
Lens Distortion, 317–318
reusing, 203–204
rolling shutter reduction, 

312–313
selecting, 203
Shadow/Highlight, 315–317
Timecode, 314–315
using with video, 291–293
Warp Stabilizer, 312–313

EQ effect
displaying audio meters, 270
using, 268–271

events, triggering during video 
playback, 128

Exponential Fade crossfade, 159
export effects, 441
export options, 432
exporting. See also Media Encoder

to AAF (Advanced Authoring 
Format), 447

to file formats, 433–434, 437–439
Final Cut Pro XML files, 445
master copies, 434–436
to OMF (Open Media 

Framework), 446
single frames, 433–434

exports, configuring, 439–441
exposure problems, fixing, 344–347
extract edit, performing, 140

F

faders, using for audio, 257
Fast Color Corrector, 342, 348–349
Feet + Frames option, using with 

video, 26
file formats, exporting to, 433–434, 

437–439
File menu, using, 414–416
file-based workflow. See tapeless 

workflow
files, collecting and copying, 418–419
Fill Type, choosing for titles, 400
filtering, bin content, 67–68
Final Cut Pro 

exporting XML files, 445
importing projects, 31–32

finding, media files, 71
Fit to Fill edit, 168
fixed effects, using with video,  

289–290, 294
Flash Cue Point marker, explained, 

125
flattened Photoshop files, importing, 

53
folders versus bins, 69. See also 

subfolders
font size, changing in Project panel, 

72
fonts, choosing for video typography, 

388
footage. See video footage

creating looks for, 355–356
interpreting, 84–85
monitoring, 76–78
playback resolution, 79
replacing, 175–179
safe margins, 79–80
timecode information, 79

four-point editing, 166–168
frame duration, setting  

default for, 67
frames. See also Program Monitor

dropping, 22
exporting, 433–434
setting for video, 26

G

gaps in Timeline, finding, 132
Gaussian Blur color effect, 355
GIF format, exporting to, 439
GoPro CineForm codec, 420, 436
GPU card, adding, 312
graphics

adding, 405–406
creating with Adobe Photoshop, 

402–403
restoring, 406

grayscale, explained, 363
greenscreen

chromakey composition, 372
color keying, 371–376
explained, 367

H

H.264 formats, exporting to, 438
handles

including, 417
using with transitions, 146–147

hard drives, managing, 29, 427–428
hardware cards, support for, 453
hardware support, 4

HDMI, using with professional 
decks, 453

HDV deck, recording to, 451–452
Highlights control, 352
Highpass and Lowpass effects, 

applying to audio noise, 
272–273

History panel, displaying in Editing 
workspace, 12

Hold keyframe interpolation, 309

I

icon view, sorting clips in, 109
Illustrator files

Editor Original option, 56
importing, 55–56

image files
adding, 405–406
creating with Adobe Photoshop, 

402–403
restoring, 406

image sequences, converting to clips, 
417

Import command
versus Media Browser, 45–46
using, 44–45

importing
from Adobe Prelude, 47–48
Avid Media Composer projects, 

32–33
Clip projects, 31
with default frame duration, 67
Final Cut Pro projects, 31–32
flattened Photoshop files, 53
Illustrator files, 55–56
layered Photoshop files, 54–55
projects, 424–426
sequences, 424–426
subfolders, 56

In marks
adding on Timeline, 102
clearing from Timeline,  

102–103
using in Source Monitor, 91, 94, 

101
using on Timeline, 102

Info panel, displaying in Editing 
workspace, 9, 12

insert edit, 105–107
insert editing with Program Monitor, 

119–120
interactive markers, using, 128
interpolation, temporal versus 

spatial, 210
interpret footage settings, preserving, 

423



Adobe Premiere Pro CC Classroom in a Book (2015 Release)  461

J

J key, using, 77
J-cut, adding to audio, 253
JPEG formats, exporting to, 438

K

K key, using, 77
kerning, choosing for video 

typography, 390–391
keyboard shortcuts

audio clip volume, 255
audio transitions, 161
Import command, 44
for markers, 127
Match Frame, 303
nudging clips, 137
playback controls, 77
Ripple Edit tool, 187
Rolling Edit tool, 187
rolling edits, 253
selecting noncontiguous effects, 

203
Selection tool, 97
trimming in Timeline, 192
zooming in, 149

keyframe controls, 4
keyframe interpolation, 210–213
keyframes

to animate layer position, 
201–203

defined, 196
dragging to make volume 

changes, 255
lining up playhead with, 198
using in time remapping, 

172–174
keyframing effects

adding, 305–307
interpolation and velocity, 

307–309
keyframing opacity, 368–369
keying, explained, 363, 366

L

L key, using, 77
label colors, changing, 73–74
Laura in the snow commercial, 453
layer position, animating, 201–203
layered Photoshop files, importing, 

54–55
layers, combining based on blend 

mode, 369–370
L-cut, adding to audio, 253

leading, choosing for video 
typography, 392–393

Lens Distortion effect, 317–318
libraries, displaying in Editing 

workspace, 9–10
Libraries panel, using, 427
lift edit, performing, 139–140
Linear keyframe interpolation, 309
Link Media option, using, 415, 

422–424
Linked Selection button, clicking, 

133
Locate command, using, 422–424
logos, aligning, 406–407
looks

creating for footage, 355–356
storing as styles, 401–402

Loudness Radar, applying to audio 
noise, 281–283

Luma waveform, viewing in Lumetri 
Scopes panel, 333

Lumetri Color panel
Basic Correction, 325–326
Color Wheels, 328–330
Creative section, 326–327
Curves section, 327–328

Lumetri color wheels, balancing, 
352–354

Lumetri looks color effect, 355
Lumetri Scopes panel

RGB parade, 338–339
Settings menu, 332
Waveform, 332–335
YUV Vectorscope, 335–337

M

Make Offline option, using in File 
menu, 415

Marker dialog box, opening, 127
markers

adding, 128–129
explained, 124
keyboard shortcuts, 127
removing, 128
types of, 124–128
using for navigation, 128

masking clips, 376–379
master clip effects, using with video, 

300–303
master copies, exporting, 434–436
Master Levels controls, 352
Match Frame keyboard shortcut,  

303
Match Sequence Settings option, 

using, 435
Matte effects, using, 375–376

mattes
explained, 367
with graphics or clips, 378–379

media, copying, 419
Media Browser

accessing, 46
accessing folders, 52
adding folders to favorites, 52
benefits, 46
displaying in Editing workspace, 

9–10
filtering assets, 52
finding assets with, 50–52
Forward and Back buttons, 52
opening multiple panels, 52
supported video file types, 49
tapeless workflow, 48–49
using to import assets, 45–46
Workspaces panel, 50

media cache
customizing, 57–58
use of storage space, 428

Media Composer projects, importing 
and exporting, 32–33

Media Encoder. See also exporting
adding stand-alone files, 444
After Effects compositions, 444
configuring exports, 439–441
export effects, 441
file formats, 437–439, 442
importing sequences, 444
modifying queues, 445
Output panel, 441–442
queuing exports, 442–444
Source panel, 441–442
watch folders, 445

media encoding, 5
media files

downloading, 29–30
finding in Project panel, 71
renaming, 417

media formats, 2, 32
media management, 428
Mercury Playback Engine, 4, 24–25, 

27
merging clips, 84
metadata

displaying in Editing workspace, 
9

support for, 5
Midtones control, 352
modifier keys, using with trim 

selections, 191
monitors, customizing, 81–82
Morph Cut effect, using, 155–156
motion, adding Ease In and Out to, 

211–213
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Motion effect
adjusting, 196
using with video, 290

Motion properties, 199–201
Motion settings

availability of, 197–199
reusing, 203–204

motion-related effects
Basic 3D, 218–219
bevels, 214
drop shadows, 213–214
Transform, 216–218

MP3 format, exporting to, 438
MPEG formats, exporting to, 438
Multiband Compressor effect, 

applying to audio noise, 
273–277

multicamera editing
process, 225
support for, 4–5
switching angles, 232–233
sync points for sequences, 

225–226
syncing with markers, 226
users of, 224

multicamera edits
flattening, 233
performing, 230–231
re-recording, 231–232

multicamera source sequences, 
adding clips to, 227–229

multicamera target sequence, 
creating, 229–230

Music Multi-Camera clip, 453
MXF OP1 formats, exporting to, 

420, 438

N

narration, recording scratch 
narration track, 59–60

navigator. See clip navigator
nesting sequences, 179–180
NLE (nonlinear editing), 2
normalizing audio, 251–252
Notch effect, applying to audio noise, 

277

O

offline clips, making, 415–416
OMF (Open Media Framework), 

exporting to, 446
online clips, making, 415–416
opacity, explained, 363, 366

Opacity effect, using with video, 290, 
367–370

Open Recent heading, links in, 21
Option key. See keyboard shortcuts
Out marks

adding on Timeline, 102
clearing from Timeline, 102–103
using in Source Monitor, 91, 94, 

101
using on Timeline, 102

over-cranking, 170
overexposed images, fixing, 346–347
overwrite edit, 105

P

P2 Movie format, exporting to, 439
paragraph text

adding, 397–399
explained, 394

Parametric EQ effect, 271
Pause control, 77
photo montage, applying transitions 

to, 151–152
Photoshop files

graphics and titles, 402–403
image tips, 55
importing, 53–54

pitch, adjusting for sound, 265–266
Play controls, 77, 80
playback controls, using, 77, 80–81
playback resolution, 79

adjusting, 121–122
pausing, 123

playback speed, changing, 168–174
playhead

identifying, 80
moving to end of sequences, 118, 

131
sending to times, 118

PNG format, exporting to, 439
point text

adding, 395–397
explained, 394

Position setting, choosing for Motion 
control, 197, 199

preferences, applying and syncing, 15
Prelude

adding markers with, 129
importing from, 47–48

Premiere Clip mobile editing app, 21
preview files, including, 417–418
preview playback, improving 

performance for, 57–59
primary color correction, 349–352

Program Monitor. See also frames
adding clips to Timeline with, 

118–119
displaying in Editing workspace, 9
features, 116–117
insert editing with, 119–120
versus Source Monitor, 117
trimming in, 186–192
using with closed captioning, 449

project files
access by multiple users, 426
managing, 30
settings, 28
size of, 426

project item name, displaying, 28
project management, 5
Project Manager

options, 417–418
using, 416

Project panel
advanced Find, 68–69
areas of, 65
bins in, 64
changing font size, 72
clicking in, 70
customizing, 65–66
displaying sorting order arrow, 67
filtering bin content, 67–68
finding assets in, 66–69
making selections in, 71
Preview Area, 66
scrolling, 67
search options, 69
toggling, 66
video editing from, 95
Zoom control, 72

Project Settings option, using in File 
menu, 415

projects. See also trimmed projects
creating, 21–22
displaying in Editing workspace, 

9–10
importing, 424–426

.prproj extension, 8, 20

Q

QuickTime format
choosing, 420
exporting to, 439

R

.R3D files, settings for, 85
Rate Stretch tool, using, 172
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raw files, working with, 85–86
real-time playback, 22–24
recording

scratch narration track, 59–60
to tape, 451–453

RED cameras, 85–86
Remove Unused option, using, 424
renaming 

clips, 74–75
media files, 417

Render and Replace feature, using, 
421–422

rendering
explained, 23–24
sequences with effects, 318

rendering effects, speeding up, 312
Replace Footage command, using, 422
replacing

clips, 175–179
footage, 175–179

reusing effects, 203–204
reverb, adding to sound, 266–267
RGB Curves effect, 342–343
RGB waveform, viewing in Lumetri 

Scopes panel, 333
Ripple Delete command, using, 140
Ripple Edit tool

keyboard shortcut, 187
using, 157, 182–184

Rolling Edit tool
keyboard shortcut, 187
using, 158

rolling edits
making, 184, 253
selecting, 190

rolling text, enabling in Titler, 408
Rotation property, using with clips, 

204–206
Rotation setting, choosing for 

Motion control, 197, 199
Roto Brush tool, using with After 

Effects, 380
rough cut, building from storyboard, 

108–109
RS-422 deck control, using with 

professional decks, 453

S

Safe Margins option
choosing, 79
hiding, 80

safe title margin, choosing for video 
typography, 393–394

Saturation control, 351

saving
custom styles, 401–402
effect presets, 310–312
interpret footage settings, 423

Scale settings, choosing for Motion 
control, 197, 199

Scratch Disks settings, 28
scratch narration track, recording, 

59–60
scrolling options, 100
SD/HD-SDI, using with professional 

decks, 453
Search bins, creating, 73
Secondary Color Correction control, 

351
Segmentation Marker, explained,  

125
segments

deleting, 138–141
extracting, 138–141

Selection tool
keyboard shortcut, 97
using as Ripple Edit tool, 184
using with clips, 133

sequence display changes, 
occurrence of, 153

sequence settings, matching for 
exporting, 434–435

sequences. See also edits
adding markers to, 126–127
adding video clips to, 90
audio tracks, 39
automating storyboards to, 

110–111
choosing presets, 34–36
closing, 98
conforming, 99
customizing, 36
displaying in Editing workspace, 9
dragging into Source Monitor, 99
explained, 20, 98
features, 99
importing, 424–426
making, 98
matching to sources, 34
Maximum Bit Depth option, 37
Maximum Render Quality 

option, 37
navigating with markers, 128
nesting, 179–180
opening in Timeline, 99
rendering with effects, 318
selecting clips in, 161
sending to Adobe SpeedGrade, 

356–358

submixes, 39
track types, 38
trimming in, 181–182

shadows, choosing for titles, 401
Shadows control, 352
shapes

aligning, 406–407
creating, 403–404

sheen, choosing for titles, 400
Shift key. See keyboard shortcuts
shots. See clips
sliding edits, making, 184–185
slip edits, making, 185–186
Snap button, identifying, 136
Solarize color effect, 355
sorting clips in icon view, 109
sound. See also audio; volume

adjusting EQ, 267–271
sweetening with audio effects, 

262–267
sound adjustments

bass, 263
delay, 264
pitch, 265
reverb, 266–267
treble, 265–266

Source Monitor
Add Marker control, 93
changing buttons at bottom of, 

81–82
creating subclips, 95–96
displaying in Editing workspace, 

9–10
Go to In control, 93
Go to Out control, 93
identifying active panel, 91
Insert control, 93
loading clips in, 91–92
loading multiple clips, 92
Mark In and Mark Out controls, 

93
In marks, 91, 94, 101
Out marks, 91, 94, 101
Overwrite control, 93
versus Program Monitor, 117
selecting ranges in clips, 93–95
tool tips, 95
trimming in, 181
using, 12–14
viewing video clips in, 90

source tracks, identifying, 101
spatial interpolation, 210
speed of clips, changing, 175
SpeedGrade, sending sequences to, 

356–358
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spelling mistakes, avoiding, 399
spill, avoiding, 366
Step controls, identifying, 80
stereo, audio channels for, 241
still images, setting duration for, 109
storage space, use of, 428
storage systems, 29
storyboard editing, 108–111
stroke, choosing for titles, 400
subclips, creating in Source Monitor, 

95–96. See also clips; video clips
subfolders, importing, 56. See also 

folders versus bins
submixes, choosing output options 

for, 39
sweetening sound, 262–267
sync locks, using, 130–131

T

tape
recording to, 451–453
and tapeless formats, 2

tapeless workflow
versus tape workflow, 58
using, 48–49

Targa format, exporting to, 439
temporal interpolation, 210
text. See also Titler

crawling, 408–409
on path, 394
resizing, 396
setting, 393
rolling, 408–409
wrapping, 396

text styles, saving, 401–402
Theft Unexpected clip, 453
three-point editing, 107
Three-Way Color Corrector, 342
Through Edit icon, using with clips, 

135
thumbnails, representing clips in, 76
TIFF format, exporting to, 439
time remapping, 172–174, 290
time rulers

identifying, 80
using, 103

timebase, explained, 109
timecode

setting for video, 26
viewing, 79

timecode numbers
displaying in time ruler, 95
entering with numeric keypad, 

95

Timeline
displaying in Editing workspace, 

9–10
features, 97–98
finding clips in, 130
finding gaps in, 132
In marks, 102
opening sequences in, 99
Out marks, 102
sequences, 98
track headers, 103–104
tracks, 99–100
trimming in, 192

Timeline tracks, identifying, 101
Title Designer, 5
Title Properties panel, 399–400
Titler. See also text; video typography

panels, 384–387
rolling text, 408

titles
changing appearance of, 399–401
creating with Adobe Photoshop, 

402–403
making available to projects, 387
paragraph text, 397–399
point text, 395–397
tools for, 394

title-safe margins, turn off, 393–394
Tonal Range Definition control, 351
tool tips

Source Monitor, 95
for track headers, 105

Tools panel, displaying in Editing 
workspace, 9, 12

track headers, customizing, 103–104
track height, adjusting, 100, 173
track locks, using, 132
Track Matte Key effect, using, 

378–379
track types, 38
tracking, choosing for video 

typography, 391
tracks

adding clips to, 99
displaying in Editing workspace, 

9–10
explained, 99–100
selecting all clips on, 134
targeting, 100–101

Transform effect, adding motion 
with, 216–218

transition effects, swapping, 150
transitions. See also audio transitions; 

video transitions
adjusting, 156–157

avoiding overuse, 146
best practices, 145–146
customizing, 153–155
edit points, 146–147
explained, 144–145
fine-tuning, 153–158
guidelines for use of, 145
handles, 146–147
head and tail handles, 156–157
sequence delay changes, 153
shortening when trimming, 155
website, 147

treble, adjusting for sound, 265–266
trim selections, using modifier keys 

with, 191
trimmed projects, creating, 419–421. 

See also projects
trimming. See also editing techniques

advanced, 182–186
with keyboard, 192
making ripple edits, 182–184
making rolling edits, 184
making slip edits, 185–186
in Program Monitor, 186–192
regular, 180–182
in sequences, 181–182
shortening transitions during, 

155
in Source Monitor, 181
support for, 5
in Timeline, 192

Type tool, accessing, 395

U

Ultra Key effect, using, 373–376
Uncompressed Microsoft AVI 

format, exporting to, 439
underexposed images, fixing, 

345–346
Undo list, History panel as, 12
user preferences, setting, 15

V

vector graphics, placing in titles, 
405–406

video, 8-bit, 322–323
video clips. See also clips

adding to sequences, 90
measuring time for, 25–27
playing at multiple speeds, 77
selecting, 134
viewing on second monitors, 92

Video Display Format, 25–26
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video editing from Project panel, 95 
video effects. See also visual effects

adjustment layers, 295–298
applying, 293–295
changing parameters for,  

306–307
Clip Name, 314–315
Effects panel, 291–293
fixed, 289–290, 294
image stabilization, 312–313
interpolation methods, 309
keyframing, 305–309
lens distortion removal,  

317–318
master clips, 300–303
multiple GPUs, 312
presets, 310–312
render all sequences, 318
rolling shutter reduction, 

312–313
sending clips to After Effects, 

298–300
Shadow/Highlight, 315–317
Timecode, 314–315
Warp Stabilizer, 312–313
YUV, 292–293

video footage
creating looks for, 355–356
interpreting, 84–85
monitoring, 76–78
playback resolution, 79
replacing, 175–179
safe margins, 79–80
timecode information, 79

video input/output devices, 
availability of, 452–453

Video Limiter effect, 343–344
video playback, triggering events 

during, 128
video transitions. See also transitions

anti-aliasing method, 150
applying between clips, 149–151
applying to multiple clips, 

151–152
single-sided, 148–149
subcategories, 147

video typography. See also Titler
alignment, 393
colors, 388–391
fonts, 388
kerning, 390–391
leading, 392–393
safe title margin, 393
tracking, 391

video workflow
enhancing, 4–5
incorporating components into, 

5–6
process, 3–4
scenarios, 6–7

visual effects, masking and tracking, 
303–305. See also video effects

voice-over “scratch track,” creating, 
247–248

volume, smoothing between 
keyframes, 256. See also audio; 
sound

volume changes, keyframing, 255

W

Warp Stabilizer effect, 312–313
Waveform Audio format, exporting 

to, 439
Web Link marker, explained, 125
white balance, correcting, 348–349
Windows Media format, exporting 

to, 439
workflow

enhancing, 4–5
incorporating components into, 

5–6
process, 3–4
scenarios, 6–7

workspaces, displaying, 9
Workspaces panel, displaying, 50
Wraptor DCP format, exporting to, 

439

Y

YC waveforms, viewing in Lumetri 
Scopes panel, 333

YUV effects, using with video, 
292–293

YUV Vectorscope, viewing in 
Lumetri Scopes panel,  
335–337

Z

Zoom control, setting to 100%, 78
zooming in keyboard shortcut, 149
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